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CHAPTER 2

Workspace Overview

In this section, we introduce the workspace and the tools you will 

find there, and also details setting your workspace default settings 

using the Preferences tool.

Topics covered in this chapter:

• Description of the workspace areas

• Creating and altering designs 

• Setting up the design workspace environment.
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The Workspace - 
Overview
The image below shows the Preview Quilt 

Design workspace, showing the various 

different areas. The sections that follow give a 

brief description of the properties/functions of 

each.

Quick Access Tools
At the top left-hand corner of the window is the 

Quick Access   tool. Click on this button 

to expand a  list access to a menu of useful 

tools, such as New, Save, Print, and several 

others. 

Also on the quick access drop down, a list of 

recent design files will be displayed. Just 

double-click on the file name to open it.

Workspace Tabs
The tabs are aligned across the top of the 

workspace. Under these, you will find the tool 

icons for creating and editing quilt projects and 

individual quilt blocks.  .

Quilt Tab
Refer to the Quilt tab when you are building 

new quilts, or modifying an existing quilt 

design. On this tab, you can set the following 

quilt properties.

• Layout (number of blocks and down)

• Block size (width and height) 

• Sashing: Width of spacing between blocks 

in the quilt

Tool What it means

New Quilt: Creates a new Quilt, which 
opens in its own tab.

New Block: Opens a new  tab on which 
you can create a new custom block.

Open: Opens an existing design file.

Save: Saves the current design.

Save As: Opens the Save As dialog, 
allowing you to choose the destination 
and file type to save it as.

Export Image: Creates an image file 
based on the current design, which can 
be saved as a *.bmp, *.jpg, or *.png file.

Print: Opens the printer dialog on your 
computer, allowing you to choose your 
printer and adjust the printer’s properties. 

Direct Print: Prints a copy of the design 
worksheet, bypassing the printer dialog.

Print Preview: Opens the print preview 
window, which in turn will let you print the 
current design.

Print Setup: Opens the print setup 
dialog, which allows you to select the 
printer, and to modify print properties.

Exit: Closes all open files and shuts 
down the software; you will be prompted 
to save any open files.

Tool What it means
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• Border: Horizontal and vertical dimensions 

of the outside border around the quilt.

• Sashing and Border style and colors

Block Tab
On the Block tab, you will find the tools and 

and setting relating to individual quilt blocks. 

You can use the tools to create new custom 

blocks, and to modify existing blocks. 

The following properties of the current Block 

can be adjusted on this tab.

• Style: When you are filling in the piece of a 

custom block with color, the block tab 

overlays an array of “cells” that you select 

and fill in. Four different styles that can be 

applied: Rectangle,Triangular,Triangle up 

or Triangle down. 

• Across and Down: The horizontal and 

vertical dimensions of the overlay grid, in 

number of cells 

• Width and Height: Absolute size of the 

block (in inches or mm).

View Tab
The View tab contains a number of check 

boxes, which can be checked or unchecked to 

show or hide areas of the workspace. You can 

use the check boxes to show/hide these areas:

• Palette

• Block Colors palette

• Blocks panel

• Library panel

• Blocks

• Status line

It also includes the Program Preference tool, 

which allows you to change the Environment 

and Grid settings.

For more information, see “Setting up the 

Workspace Environment”, later in this chapter.

Block and Library Panels
The Library and Block panels is located to the 

right side of the workspace. In the Library 

panel, you see a list of categories of blocks, 

including a “Custom” category for the blocks 

you create. 

When you select a catergory in the Library, the 

Blocks panel will display thumbnail images of 

the quilt blocks in that catergory. You can then 

drag these onto the Quilt tab in the workspace 

to build your quilt.

See Creating a New Quilt–Adding Blocks to a 

Quilt” for details. 

Working with Fill 
Colors

Color Palette
The Palette shows all the available colors that 

you can apply to a quilt block. It consists of a 

series of squares (“swatches”) and is located 

along the bottom of the workspace. You can 

select any color from the Color Palette, and 

add it to the Block colors palette.

To show the  Palette, or Block Colors palette  

open the View tab, and check the 

corresponding check box. Alternatively, if you 

want to hide either palette, uncheck the  

corresponding box.
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Block Colors Palette
The Block Colors palette shows the colors that 

are used in the current design. This palette 

keeps all the colors that are in use in a single 

array, for easy reference.

To add a color to the Block Colors palette, 

simply go to the Palette, and click on the color 

“swatch” that you want to add. The color will 

immediately be added to the list of Block 

Colors.

The  palettes: Block Colors  (top) and color Palette 

(below).

Status Line
The Status Line appears at the bottom of the 

Preview Quilt Design workspace. This line 

displays the dimensions of the quilt or block 

that is currently “on top” in the workspace. 

Note the information in the Status Line 

changes according to the context;  when a quilt 

is open, it will show the size of the quilt, and 

when a block tab is open, it will display the 

block size.

Setting up the Work-
space Environment
Preview Quilt Design allows you to set up your 

design workspace environment for all opened 

design files. You can predetermine the units of 

measurement you want to use for your 

designs, as well as decide how often open 

design files get saved. 

The preferences dialog also allows you choose 

the image editing program to use when editing 

a backdrop image.  The designated image 

editing program will open when you select 

Backdrop Tool–Edit Backdrop.

See “Working with Quilts & Quilt Blocks—

Loading a Backdrop Image”).

To set up your workspace environment

1 On the View tab, click the Program 

Preferences  tool.

You see the Preferences dialog box.

2 Click the Environment tab.

You can hide/show the Status line in the 
View toolbar.
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3 From the Units list, select the units of 

measurement you want used for your 

designs: Metric or inches.

4 From the Image editing program list, select 

the image editing program you want to use. 

If you want to use a program not listed, 

select Other Program and browse to the 

location of the program.

5 Click OK.

Setting up the Workspace 
Grid
The workpace grid can be used to help you 

align and measure artwork elements in your 

quilt design. You can display/hide the grid by 

checking/unchecking the box in the  area of 

the Home tab.

By default, every horizontal and vertical line 

will be highlighted in the major grid. If you want 

to have additional guide lines, you can add 

more major grid lines as well as a minor grid. 

You can increase or decrease the spacing of 

the minor grid. The minor grid can also have 

different horizontal and vertical spacing 

values.

To make grid lines more visible on particular 

backgrounds, you can change the color of the 

major and minor grids. If you prefer, different 

colors can be applied to the major and minor 

grids.

To define grid settings:

1 On the View tab, click Preferences  

tool and select the Grid tab.

You see the Grid settings dialog.

2 In the Grid Minor area, complete the 

following:

 In the Horizontal spacing box, enter the 
measurements for horizontal spacing in 
millimeters or inches. 

 In the Vertical spacing box, enter the 
measurements for vertical spacing in 
millimeters or inches.

 From the Color list, select a predefined 
color to use for the minor grid. If you 
want to choose from a larger selection 
of colors, click Custom from the color 
box.

3 In the Grid Major area, complete the 

following:

 In the Horizontally Every (lines) box, 
enter how often you want horizontal 
lines to be highlighted in the major grid. 
For example, if you enter 3 in this box, 
every third horizontal line will be 
highlighted in the major grid.

You can also select the units of measure-
ment in your design workspace; to do this, 
right-click on one of  the rulers and select 
Metric or English from the context menu.



8 CHAPTER 2

Workspace Overview
 In the Vertically Every (lines) box, enter 
how often you want vertical lines to be 
highlighted in the major grid. For 
example, if you enter 5 in this box, 
every fifth vertical line will be 
highlighted in the major grid.

 From the Color list, select a predefined 
color to use for the major grid. If you 
want to choose from a larger selection 
of colors, click Custom from the color 
box.

4 In the Style area, select one of the 

following grid styles:

 Show grid as solid lines.

 Show grid as dashed lines.

 Show grid as dots.

5 Click OK.

Changing the Workspace 
Background
Depending on the color values of the Quilt or 

Block  you are creating, you may want to 

change the background color of the workpace 

to a color other than white, to contrast better; 

or, if you want to use a fabric image as the 

workspace background you can select a fabric 

image instead. You can apply either of these 

options in Preview Quilt Design.

To change the background color of the 
Workspace: 

1 Select either the Qullt tab or the Block tab. 

2 Click the Background  tool.

3 To change the backgrond to a differernt 

color, do the following:

 On the drop-down, click Select Color.

You see the colors dialog.

 On the Color dialog, select the desired 
background color from the one of the 
color swatches.

 Click OK.

The new color chosen replaces the old color 
on your design workspace.

4 To change the workspace to show a fabric  

background,do the following: 

 On the Background tool drop-down list, 
select Select Fabric.

You see the Load Fabric dialog.

 In the Look in field, navigate to the 
directory or folder containing the fabric 
images.

 Select a fabric image, and click OK.

The fabric will appear in the background; 
the image will be tiled so as to fill the whole 
background.

If  you do not see a suitable color in the Basic 
colors matrix (left side of the dialog), click in 
the color “rainbow” on the right to select a 
different color. Then, click “Add to Custom 
Colors”. The new color will now appear in the 
Custom Colors area of the dialog, where it 
can be selected.
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Using Zoom Tools
Use Zoom to magnify or reduce in size the 

design view. With Zoom  enabled you can 

either left-click to enlarge your design or right-

click to make your design smaller.

When you select Zoom, the cursor changes to 

a small magnifying glass  To use the Zoom 

tool, do one of the following: 

• To zoom in on the spot where the mouse is 
currently pointing, left-click.

• To zoom out again, right-click.

• To zoom in on a particular area, left-click 
and drag; the display will expand to show 
only the area that you have dragged over.

To use the Zoom Tool: 

1 On the Tabs bar, select either of the Quilt or 

Block tabs.

2 On the tab, click the Zoom  tool.

The pointer becomes a magnifying glass.

3 Do either of the following:

 Left-click to make your design larger. 

 Right-click that area to make your 
design smaller.

Additional Zoom Options 
Aside from the basic Zoom tool, the Zoom area 

of the Quilt and Block tabs include these other 

tools for enlarging/reducing the magnification 

of the workspace :

• Zoom In  to make your design larger.

• Zoom Out to make your design 

smaller.

• To Fit  to make the whole design fit in 

the design window.

• 1:1  to see the design at the actual 

size.

Opening an Existing 
Quilt Design
If you have a quilt or block design that has 

been saved to disk, and you want to modify it, 

use the Open tool.

To open an existing design:

1 On the Quick Access toolbar, click the 

Open  tool. 

You see the Open Design dialog box.

2 In the Look in list, browse to the location of 

the file you want to open..

3 In the File name box, enter the file name, or 

select the file you want to open by clicking 

the file.

4 Select Preview to view a thumbnail (a small 

representation) of the design. 

5 Click Open.

Saving Designs
You can use Save or Save As to save blocks 

and quilt designs.

To limit the number of displayed designs in 
the Open Design dialog, you can enter the 
first letter of the design name, followed by 
an asterisk (*) and the file extension.
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Save and Save As
The Save As command lets you save an alter-

native version of the design with a different 

name, location, or file format. Save As is 

handy when you want to keep your original 

design and create another design with slight 

modifications. The Save command saves the 

changes you make to the current design.

To save a design:

1 Do one of the following:

 On the Quick Access toolbar, select the 

Save  or Save As  tools.

 Press Ctrl + S on the keyboard.

You see the Save As dialog box.

2 In the Save in list, browse to the location 

you want to save your file. You can save 

design files to your hard drive or external 

memory device.

3 In the File Name box, enter the file name 

for the design you want to be saved.

4 In the Save As type list, select the file type 

you want the design to be saved as.

5 Click Save.

The Quilt or Block will be saved in the 
selected location.
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Working with Quilts & Quilt 
Blocks

The tools on the Quilt tab and the Block tab are used to create quilt 

designs and quilt blocks. On the library panel, you can select 

existing blocks and drag them onto a quilt grid, in order to put 

together a complete Quilt design. 

You can also make new Blocks and customize the color of the 

pieces within them.

Topics covered in this chapter:

• Configuring the quilt grid.

• Assembling new quilts

• Loading a backdrop image.

• Creating a custom quilt block

• Using Block editing tools.

• Outputting designs to the printer

• Exporting designs as image files
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Creating a New Quilt 
When the program opens initially, it will create 

a new, blank 4 X 4 square quilt by default. You 

have the option of either modifying this default 

quilt, or creating a new quilt completely from 

scratch using the New Quilt  tool.

To create a New Quilt:

1 Do one of the following:

 Click on the New Quilt  tool.

 Press Ctrl+N on the keyboard.

A new grid appears in the workspace, on its 
own tab. 
Initially, the grid will have the default pattern 
(4 × 4) and block dimensions.

2 On the Quilt tab, adjust the following:

 In the layout area, adjust the number of 
rows and/or columns of quilt squares by 
entering new values in the layout fields.

 In the Block area, adjust the width and/
or height values for individual blocks.

 In the Sashing area, adjust the 
horizontal and/or vertical sashing. This 

sets the spacing between rows and 
columns of blocks, within the Quilt Grid.

 In the Border area, adjust the size of 
the quilt border; this sets the size of the 
border that goes around to outside of 
the Quilt

3 Grid Style: Choose either solid or dashed 

lines.

4 (Optional) Change the Sashing color: Click 

the down-arrow to the right of the Sashing 

Color area and select a new color from the 

grid.

5 (Optional) Choose the Border color. Click 

the down-arrow to the right of the Border 

Color field and select a new color from the 

list of color squares.

The Quilt settings will be automatically 
updated accordingly.

Any of the above values can also be 
adjusted up and down by clicking the arrows 
to the right of the corresponding field.

For both Sashing and Border colors, you can 
select the “More Colors” option, if you want a 
specific color for these settings; this will open 
the Colors dialog, which allows you to create 
custom colors that can be applied to the 
sashing and Border areas.
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Adding Blocks to the Quilt
Once the quilt “grid” (design) has been set up 

as required for your project, you will want to 

add quilt blocks to it. You can add blocks from 

the block tab or directly from the Library.

You can also build the quilt by cutting and 

pasting blocks within the quilt grid.

To add a Block to the quilt project:

1 On the Quilt tab, click the Select block  

tool.

2 Click on a block outline to select it.

3 In the Library, click on one of the block 

categories (e.g. Flowers, Paths, Pinwheels, 

etc) to select it.

The blocks in the selected category will now 
be previewed in the Blocks panel.

4 In the Blocks panel, click on the block you 

want to add to select it, then drag and drop 

it to place it on the grid.

The block will be placed in selected square 
of the quilt grid.

5 Repeat the above step(s) to fill each 

square in the grid.

6 Save the Quilt design.

To place blocks by pasting:

1 On the Quilt tab, click the Select block  

tool.

2 In the Quilt grid, click on the block you want 

to copy and paste. 
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3 Click Ctrl+C to copy the selected block.

4 Click in the location you want to place the 

block.

The square will change outline color, to 
show that it has been selected.

5 Left-click to open the context menu. Select 

one of the following paste options:

 Paste (places the block in the selected 
square only).

 Paste to all blocks.

 Paste to selected row.

 Paste to selected column.

 Paste to every other.

The quilt squares will be filled in according 
to the selected

Some examples of using the paste commands: top, 
Paste to selected row; middle, Paste to selected 
column; bottom, Paste to every other.
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Creating New Blocks
You can create new quilt blocks using the New 

Block  tool. When a new block is created, 

it will appear in the “Custom” directory of the 

quilt

Loading a Backdrop

You can use the Backdrop  tool to import 

an image file into the workspace to serve as a 

backdrop. You can then use this image as a 

guide for creating new custom quilt blocks with 

the New Block tool; for more information on 

using the New Block tool, see following 

procedure, “Creating a Custom Block”

To load a backdrop image:

1 On the Block tab, click the Backdrop  

tool.

You see a drop-down menu.

2 From the menu, select Load Backdrop...

You see the Load Backdrop dialog.

3 In the “Look in” list, navigate to the 

directory containing the backdrop images.

The images appear in the Load Backdrop 
preview window.

4 Select the backdrop you want to load, and 

click Open.

The backdrop image appears in the 
workspace

Backdrop Settings

You can adjust the size, angle, and luminance 

(color intensity) of the backdrop image on the 

Block tab. 

Adjusting the luminance of a backdrop can be 

useful for distinguishing between the 

background colors and the colors you are 

adding as you build your custom block.
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Adjusting Backdrop settings:

1 Load a Backdrop image.

2 Adjust one or more of the following:

 Scale (%): Enter a percentage value to 
change the size of the Backdrop image 
(relative to the original size).

 Luminance: Adjusts the color intensity 
of the backdrop; a large numbers 
means a less intense backdrop image 

 Fit to block: When you click this 
option, the backdrop will automatically 
scale up or down so that it fits the 
current block.

 Width and Height: Enter the 
dimensions in these fields to determine 
the size of the Backdrop.

 Angle: Enter the value (in degrees) to 
rotate the Backdrop by.

Showing and Hiding a Backdrop 
Image

Once a backdrop is loaded, you can show and 

hide it using the Backdrop tool. This hides the 

current backdrop (without removing it), so you 

can more clearly see your design work.

To hide the image click the Backdrop Tool  

button and un-check “Show backdrop” on the 

menu. To show the backdrop once again, click 

“Show Backdrop” again. 

Editing the Backdrop

If required, you can edit the Backdrop image 

using an external graphic editing program (e.g. 

MS Paint). You can then use this external 

programs to edit the image – change colors or 

resize it, for example – and then save your 

changes. When saved, the modified Backdrop 

image will appear in the Preview Quilt Design 

workspace. 

To edit the Backdrop using an external 
editor:

1 Load a backdrop image. 

2 Click the Backdrop Tool  button again 

click Edit Backdrop.

The current backdrop will open in the image 
editing program.

3 Edit the image as desired, and save it.

The modified backdrop image appears in 
the workspace.

Creating a Custom Block

Using the New Block  tool, you can create 

new, unique, quilt blocks of your own. When 

you create a New block, you overlay the 

backdrop image with a “overlay grid” 

consisting of an array of “cells”. You can then 

fill in the pieces of the new block by selecting 

and filling (“coloring in”) cells on this grid.

The completed blocks can then be saved to 

the Custom folder of the Preview Quilt 

Design’s library, making them available for use 

in assembling quilt blocks. 

See “Adding Blocks to the Quilt” above.

You can select the image editing program 
that will be used in the Preferences dialog–
Environment tab.
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To create a custom block:

1 On the quick access toolbar, select the 

New Block  tool.

You see a new tab in the workspace.

2 On the Block tab (Properties area), select 

the style to apply to the block grid overlay; 

select one of the following

 Rectangle

 Triangular

 Triangle up

 Triangle down

The style of the overlay grid will change 
accordingly 

3 In the Across and Down fields, enter the 

number rows and columns of “cells” in the 

block overlay grid.

4 In the Width and Height fields, adjust the 

dimensions of individual “cells” in the 

overlay grid, (if required).

5 On the Block tab, click the Piece Select 

 tool. Fill in the colors of the block by 

doing the following:

 On the block overlay grid, click 
individual cells to select them; hold 
down the Ctrl key while clicking to 
select multiple cells.

 Continue clicking on cells until a whole 
piece of the block has been selected.

In this example, all of the cells in the upper-
left triangle of the block are selected.

 On the Block tab, click Unite  to join 

the cells as a unit.

The style chosen should reflect the type of 
backdrop, i.e., use the rectangle style to 
make rectangular blocks and use one of the 
triangular styles if you are creating a block 
with diagonal lines in it.

Alternatively you can right-click on the block 
grid and select Unite from the context menu.

If you make a mistake, and want to de-select 
one or more cells of the piece, you can use 

the Break up  tool to separate them.



18 CHAPTER 3

Working with Quilts & Quilt Blocks
6 In the Block Color palette, click on a color 

square to change the piece to the desired 

color.

7 Repeat steps 4-6 for the other pieces of the 

block.

8 Using the Save or Save As commands, 

save the block.

The block will be saved as a Outline File 
(*BRF).

Adding a fabric fill

There is also an option to use a fabric image, 

instead of a solid color, as the fill for a block 

piece. The fabric fill can be selected from the 

pre-installed fabrics library, or you can use 

your own fabric images. 

To apply a fabric fill:

1 Using the Piece Select  tool, click on a 

piece of a quilt block.

2 To the right of the color Palette, select the 

Fabric  icon. 

You see the Fabrics dialog.

3 In the dialog, select a fabric swatch and 

click OK. 

The fabric fill appears in the selected piece 
(or pieces).

Clearing the fill from a quilt piece

You can also remove the color fill from a block 

piece, using the Clear Fills  tool. This tool 

is located on the left side of the Palette bar.

To use this tool, select an individual piece in 

the Block, and click the on the tool; the fills will 

be removed from the select piece (or pieces).

Block Editing Tools

Selecting a Block

Use the Select Block  tool to select 

individual blocks or block frame in the quilt 

grid. 

If you want the custom block to be available 
in the Blocks panel, save it the Library–
Custom folder. By default, this folder will be 
found in the following directory: 
C\ProgramData\ Pacesetter \Preview Quilt 
Design\Library\Custom.

If you want to change the fill of multiple quilt 
block pieces at the same time, you can 
select a number of pieces by holding down 
the Ctrl button while clicking.
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When block is selected, you can rotate it, copy 

it, or delete it, by right-clicking and selecting 

the corresponding command from the context 

menu.

Also, you can use the Select tool to select an 

empty block location in the quilt to paste a 

copied block into the quilt.

Selecting a Block Piece

Use Select Piece  tool to select individual 

parts of a block. When a block piece is 

selected with this tool, you can change its 

color by selecting a color “swatch” from either 

of the palettes. 

You can also rotate the selected part of the 

block using the Rotate Left or Rotate right 

tools.

Using the Palettes

Color Palette
The Palette shows all the available colors that 

you can apply to a quilt block. It consists of a 

series of squares (“swatches”) and is located 

along the bottom of the workspace. You can 

select any color from the Color Palette, and 

add it to the Block colors palette.

The palettes: Block Colors palette (top) and Color palette 
(below).

Block Colors Palette
The Block Colors palette shows the colors that 

are used in the design. This palette keeps all 

the colors that are in use in a single array, for 

easy reference.

• To add a color to the Block Colors palette, 

click on the color “swatch” that you want to 

add on the Palette; this color will 

immediately be added to the list of Block 

Colors.

Correcting Mistakes
Undo and Redo tools allow you to remove or 

re-do an setting change or edit that you have 

made. 

To use Undo: 

• Do one of the following: 

 On the Quick Access toolbar, click the 

Undo  tool. 

 Press Ctrl+Z on your keyboard.

To use Redo: 

• Do one of the following: 

 From the Quick Access toolbar, click 

the Redo  tool.

 Press Ctrl+Y on your keyboard.

Note: if Undo or Redo are grayed out, you 
cannot Undo or Redo.
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Rotating Blocks
In the block view, you can use the Rotate tools 

to rotate a block in the view and change its 

orientation.

To rotate a block: 

1 In the Block tab, select the Block  

Select tool. 

2 In the workspaces select the current Block.

3 Do one of the following:

 Click the Rotate Left  tool.

 Click the Rotate Right  tool.

The block will be rotated accordingly; to 
rotate the block again, click on the 
respective rotate tool again.

Exporting Blocks as Image files

Printing Designs
You can make print-outs of your designs in 

Preview Quilt Design. These print-outs create 

worksheets for all the individual pieces 

required for the quilt project, and include a 

dashed outline around each piece to represent 

the seam allowance. 

The print preview includes a color analysis 

page at the very end. This page summarizes 

all the characteristics of the cut pieces - It has 

sections displaying the border and sashing 

dimensions, and includes tables that list all the 

colors used in each quilt block, plus the 

number of cuts required for each color.

Previewing a Design 
before Printing
You can preview a worksheet on the screen 

before sending it to the printer.

To preview the quilt design worksheets:

1 Click the Quick Access  button.

2 On the Quick Access list, click Print — Print 

Preview .

3 To zoom in and out of the previewed 

worksheet, do the following:

 To zoom in on the worksheet, click 
Zoom In and scroll to view specific 
parts of the design.

 To zoom out on the worksheet, click 
Zoom Out and scroll to view specific 
parts of the design.

4 To close print preview and return to the 

design window, click Close.

Printing Design 
Worksheets
You can print a design, without previewing it. 

On the Quick Access tools drop-down list, 

select Print  and then Print Setup . 

This button opens your computer’s Print dia-

log, where you can choose printer options 

such as how many copies you want to print.

You can also print worksheets of your design 

immediately, without previewing the design or 

changing printer options. To do this, use the 

Direct Print  tool.



Preview Quilt Design 21

User’s Guide
To print a worksheet for your design:

1 Do one of the following:

 On the Quick Access menu, select 

Print— Print Setup .

 Press Ctrl+P on the keyboard. 

You see the Print Setup dialog.

2 Make any required changes to the print 

settings.

3 Click OK to send the file to the printer.

Changing the Print 
Settings
You can customize print settings for your 

embroidery designs. On the Print settings 

dialog, you to adjust the image and worksheet 

information displayed in design printouts.

To change a design’s print settings:

1 Click the Quick Access  button.

2 On the drop-down list, select the Print—

Print Preview .

You see the print preview window, 
displaying your design.

3 On the preview’s toolbar, click Settings.

You see the Print Settings dialog.

4 In the Margins area, enter the margins 

(Top, Bottom, Left and Right) for your 

design worksheet.

5 Select Print Company Name to have the 

name of your company name printed on 

your design worksheet. Enter your 

company name in the field underneath this 

check box.

6 Click OK to save the changes to print 

settings.

7 Click Print to print out the print preview, of 

Close to exit without printing.
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Exporting Designs as 
Image files
If you want to save or send design as an 

image, you can be exported as images files. 

The Export Image tool can be used to save 

both individual Blocks or whole quilts as an 

image file. You can save the images as *.BMP, 

*.JPG or *.PNG.

To export a design as an image:

1 Open a Quilt or Block design.

2 Click the Quick Access  button, and 

select Export Image  from the menu.

You see the Image dialog.

3 In the Save in list, browse to the folder or 

directory you want to save your file. 

4 In the File Name field, enter the file name 

for the design.

5 In the Save as type: field, choose a file type 

to save as - *.BMP, *.JPG, *.PNG or *.GIF.

6 Click Save.

You see the Export Image dialog.

7 Set the size (width and height) of the 

image. 

8 (Optional) Check the Crop Image box to 

remove the white space from around the 

outside of the image.

9 Click OK.

The image of the design will be saved to the 
selected directory
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